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1  Sobre este documento

1.1  Função do documento
Estas instruções oferecem todas as informações necessárias para uso do software: da
descrição do produto, instalação e uso à integração do sistema, operação, diagnóstico e
localização de falhas até atualizações do software e descarte.

1.2  Símbolos usados

1.2.1  Símbolos de segurança
PERIGO

Esse símbolo alerta sobre uma situação perigosa. Se a situação não for evitada resultará
em ferimento grave ou fatal.

ATENÇÃO

Esse símbolo alerta sobre uma situação perigosa. Se a situação não for evitada pode
resultar em ferimento grave ou fatal.

CUIDADO

Esse símbolo alerta sobre uma situação perigosa. Se a situação não for evitada pode
resultar em ferimento leve ou médio.

AVISO

Esse símbolo contém informações sobre os procedimento e outros fatos que não resultam
em ferimento.

1.2.2  Símbolos para determinados tipos de informações

Símbolo Significado

Permitido
Procedimentos, processos ou ações permitidos.

Preferível
Procedimentos, processos ou ações preferíveis.

Proibido
Procedimentos, processos ou ações proibidos.

Dica
Indica informação adicional.

Referência para a documentação

A Consulte a página

Referência ao gráfico

Aviso ou etapa individual a ser observada

1. , 2. , 3.… Série de etapas

Resultado de uma etapa

Ajuda em caso de problema

Inspeção visual
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1.2.3  Símbolos do FieldCare

Símbolo Significado

Iniciar novo projeto.

Abrir projeto existente.

Salvar projeto aberto.

Imprimir projeto aberto.

Abrir área de transferência.

Exibição do catálogo de DTM.

Abrir documentação para equipamento selecionado ou informação detalhada de equipamentos.

Abrir inventário.

Ativar protocolo.

Adicionar novo equipamento à rede.

Remover equipamento da rede.

Criar nova topologia de rede usando CommDTM e DeviceDTMs.

Compara a topologia de rede no campo com a rede física real e os equipamentos são adicionados à
rede existente.

Examina a topologia pré-configurada e mostra o relatório com a informação do dispositivo
escaneada.

Indica se há uma conexão com o equipamento.

Transfere informações do equipamento para o FieldCare.

Transfere informações do FieldCare para o equipamento.

Funções específicas do equipamento para o equipamento selecionado.

Adicionar nível da fábrica.

Adicionar item.

Remover nível da fábrica.

Remover item.

Abrir lista de verificação do equipamento para mostrar equipamentos selecionados na fábrica.

Confirmar equipamento substituído.

Desconectado.  1)
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Símbolo Significado

Configuração da comunicação, pronto para comunicação  1)

Canal de comunicação ocupado ou ação de comunicação cancelada. 1)

Conectado  1)

Ligar modo sensível ao toque

Desligar modo sensível ao toque

1) Indicador de status: indicação de status online/offline de equipamentos na fábrica e visualização de rede

1.3  Ênfase do texto

Ênfase Significado Exemplo

Negrito Teclas, botões, ícones de programas, abas, menus,
comandos

Iniciar → Programas → Endress+Hauser
No menu Arquivo, selecione a opção Imprimir.

1.4  Acrônimos usados

Acrônimos Significado

APL Advanced Physical Layer (Camada física avançada)

CSV Comma Separated Value (Valor separado por vírgula)

DTM Device Type Manager (Gerenciador de tipo de equipamento (driver para equipamentos))

FDI Field Device Integration (Integração de equipamento de campo)

FDT Field Device Tool (Ferramenta de equipamento de campo)

HART Highway Addressable Remote Transducer (Transdutor remoto viário endereçado)

I/O Entrada/saída

IO-Link Nome patenteado para um sistema de comunicação que inclui sensores inteligentes e atuadores

IODD Electronic device description (Descrição eletrônica do equipamento (Descrição de equipamento de
E/S))

IP Internet Protocol (Protocolo de Internet)

PROFIBUS Process Field Bus (Processamento de barramento de campo)

PROFINET Process Field Network (Processamento de rede de campo)

SLM Software License Management (Gerenciamento de licenças de software)

TCP Transmission Control Protocol (Protocolo de controle da transmissão)

UDP User Datagram Protocol (Protocolo de datagrama de usuário)

URL Uniform Resource Locator (Localizador de recursos uniformes)

1.5  Documentação
FieldCare SFE500
• Introdução KA01303S
• Tutorial para projetos FieldCare SD01928S
• Informações técnicas TI00028S
• Manual de segurança SD03193S
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1.6  Marcas registradas
PROFINET® é uma marca registrada da organização do usuário PROFIBUS, Karlsruhe/
Alemanha.

PROFIBUS® é uma marca registrada da organização do usuário PROFIBUS, Karlsruhe/
Alemanha.

IO-Link® é uma marca registrada da IO-Link Community a/c Organização de usuários
PROFIBUS, (PNO) Karlsruhe/Alemanha

FOUNDATIONTM Fieldbus é a marca registrada do FieldComm Group, Austin, TX 78759,
EUA.

HART®, WirelessHART® é a marca registrada do FieldComm Group, Austin, TX 78759,
EUA.

Ethernet/IP é marca registrada de ODVA, Michigan EUA.

Modbus® é uma marca registrada da Modbus Organization, Hopkinton, EUA

Todas as outras marcas e nomes de produtos são marcas registradas das empresas e
organizações em questão.
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2  Instruções básicas de segurança

2.1  Especificações para o pessoal
Acesso físico e eletrônico a equipamentos de campo, redes, computadores e sistemas
devem ser restritos a um grupo autorizado de indivíduos. Portanto, um sistema de acesso
com base em função deve ser usado. Estabeleça orientações detalhadas e processos para
apenas permitir acesso de pessoas autorizadas ao PC ou a outro equipamento.

2.2  Uso indicado
O FieldCare é uma ferramenta de gestão de ativos industriais baseada em FDT (Field
Device Tool - ferramenta de equipamento de campo) que, dependendo da versão, pode ser
usada para configuração de parâmetros, gestão de instrumentos ou monitoramento das
condições. Pelo uso de gerenciamentos de tipo de equipamento (DTMs), é possível operar
equipamentos de campo e componentes de sistema independentes de protocolo de
comunicação.

Um firewall configurado adequadamente deve ser usado, que bloqueia todos os dados que
não atendam às especificações de segurança. Para aumentar ainda mais a segurança, as
portas que não estiverem em uso devem ser desativadas, e uma zona desmilitarizada ou
sistema de detecção de intrusão deve ser usado. Um processo de gerenciamento de
fragmentos organizado e adequado deve estar no local para todos os produtos, por
exemplo, sistemas de operação, navegadores de internet, programas, aplicativos, bases de
dados e drivers. Da mesma forma, um software de antivírus deve ser usado no PC.
Hardware, software, firmware e outros conteúdos eletrônicos devem ser usados somente
se fornecidos por fontes confiáveis.

O uso de senhas seguras para acesso eletrônico a programas, por ex. para o PC, FieldCare,
servidor SQL e equipamentos de campo, é recomendado:
• Que a senha tenha pelo menos 8 caracteres
• Que não seja usado um nome de usuário, nomes ou nomes de empresa
• Que não contenha uma palavra completa
• Que difira significativamente de senhas anteriores
• Que inclua letras maiúsculas, letras minúsculas, um número e um símbolo
• Que seja alterada regularmente

Para informações detalhadas de segurança, consulte o Manual de Segurança
SD03193S (www.endress.com/SFE500)

2.3  Segurança do produto
DEP - Prevenção de execução de dados
DEP é uma ferramenta de segurança que ajuda a manter vírus, danos e ameaças à
segurança longe de seu computador. Ao monitorar programas, a DEP pode ajudar a
proteger o computador e assegurar que os aplicativos usem a memória do sistema com
segurança. Assim que uma aplicação tenta acessar um programa, a DEP fecha o programa.

Configurando a DEP
1. Clique na tecla Windows → tecla Pause → Configurações avançadas do sistema →

Avançadas.

2. Insira a senha do administrador quando solicitada.

3. Selecione Desempenho → Configurações.

4. Clique na aba Prevenção de execução de dados e depois selecione Ligar a DEP para
todos os programas e serviços. Se o programa não estiver na lista, clique em
Adicionar, selecione o programa e clique em Abrir.
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5. Clique em OK.
 A caixa de diálogo "Propriedades do sistema" é aberta.

6. Clique em OK.

7. Reinicie o computador para ativar as alterações.

Número Explicação Status

0 Sempre desligado A DEP é desligada para todos os processos.

1 Sempre ligado A DEP é ligada para todos os processos.

2 Opção de entrada A DEP é ligada para os principais programas e serviços do Windows, configuração
padrão.

3 Opção de saída A DEP é possível para todos os processos, com exceção dos programas e serviços.

Melhorias técnicas
A Endress+Hauser reserva-se o direito de fazer melhorias técnicas no software e
equipamentos a qualquer momento e sem notificação anterior. Se tais melhorias não
tiverem efeito na operação do software, elas não são documentadas. Se as melhorias
afetarem a operação, uma nova versão das Instruções de operação são criadas e emitidas.

2.4  Segurança de TI
Nossa garantia é válida somente se o equipamento for instalado e usado como descrito nas
Instruções de Operação. O equipamento está equipado com mecanismos de segurança para
protegê-lo contra quaisquer alterações inadvertidas nas configurações.

As medidas de segurança de TI, que fornecem proteção adicional para o equipamento e a
transferência de dados associada, devem ser implementadas pelos próprios operadores de
acordo com suas normas de segurança.
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3  Descrição do produto

3.1  Função do software
Essas Instruções de operação descrevem como o FieldCare pode ser usado para estabelecer
uma conexão com os equipamentos HART, PROFIBUS, FOUNDATION Fieldbus, Modbus,
IO-Link e EtherNet/IP usando modems, gateways e E/S remotas.

3.1.1  Gerenciamento de licenças de software (SLM)
Informações detalhadas sobre o "Gerenciamento de licenças de software ": Inicialização
→   8

3.1.2  Funções do usuário
O login do usuário é desabilitado inicialmente após a instalação do FieldCare de modo
que o FieldCare possa ser iniciado sem ter de fazer o login.

Ativação do login do usuário
1. Abra o Administrador FieldCare →   16.

2.

User and User Groups →Configuration deve ser selecionado eUser Login active
ativado.

Funções do usuário
Diversas funções de usuário estão disponíveis. Cada usuário faz o login com uma função
específica atribuída a ele(a). O usuário recebe autorização para certas funções. Isso
assegura que apenas usuários autorizados tenham acesso a recursos técnicos e de
operação. Além disso, os direitos podem ser definidos por um período determinado.

• Criar qualquer número de usuários
• Atribuir configurações opcionais à conta de usuário
• Alterar a senha seguindo as configurações opcionais
• Os usuários podem alterar a senha
• A senha do usuário é válida por um período específico
• Desativar a conta de usuário se necessário
• Atribuir uma função de usuário de acordo com o padrão FDT

Função do usuário Autorização

Administrador Acesso irrestrito para executar todas as funções, por ex. desenvolvimento,
comissionamento e fases de tempo de execução FieldCare.

Tarefas administrativas, por ex. alocar contas de usuários.

Alterar ou atualizar o catálogo DTM.

Engenharia de
planejamento

Acesso irrestrito para executar todas as funções, por ex. desenvolvimento,
comissionamento e fases de tempo de execução FieldCare.

Engenharia de manutenção Executar o comissionamento autorizado e fases de tempo de execução.

Substituir, calibrar e ajudar os equipamentos.

Escrever os parâmetros para equipamentos, alterar ou ler os parâmetros.

Executar as operações específicas de equipamento no modo online.
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Função do usuário Autorização

Usuário Executar o comissionamento autorizado e fases de tempo de execução.

Observar e gerenciar o processo atual.

Verificar o status atual de um equipamento.

Alterar pontos de ajuste para assegurar que o equipamento esteja funcionando
corretamente.

Observador Observar e gerenciar o processo atual.

Ler os parâmetros e documentos dos equipamentos dos equipamentos conectados.

3.2  Campo de aplicação
FieldCare é a ferramenta universal para configurar e gerenciar equipamentos de campo
inteligentes. Configuração fácil do equipamento, gerenciamento da manutenção,
manutenção com base nas condições e gestão de ativos industriais são todos possíveis.
Pode ser adaptado a diferentes necessidades dependendo da licença e, portanto, pode
receber um upgrade a qualquer momento.
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4  Instalação
Informações detalhadas sobre a "Instalação": Inicialização →   8
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5  Operação

5.1  Inicialização do FieldCare
‣

Abra o FieldCare.
 O FieldCare é aberto.

5.2  Realizando configurações no FieldCare
1. Inicie o FieldCare→   15.

2. Feche a caixa de diálogo "FieldCare".
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3. Clique em Extras→ Options.
 A caixa de diálogo “Options” é aberta.

4. Faça os ajustes necessários, por ex., idioma.

5. Salve as alterações com OK.

5.3  Realizando configurações no FieldCare
Administration

Feche o FieldCare antes de iniciar a Administração do FieldCare.
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1.

Abra o FieldCare Administration.
 A caixa de diálogo “FieldCare Administrator Login” é aberta.

2. Insira o nome de usuárioAdministrator e a senhaAdmin e clique em Login.
 A caixa de diálogo “FieldCare admin” é aberta.

3. Selecione o menu desejado na coluna esquerda da janela, por exemplo Users.

4. Abra o menu de contexto e execute as configurações necessárias.

5. Salve as alterações.
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5.4  Interface do usuário

 1 Diálogo principal do FieldCare

1 Visualização da fábrica
2 Visualização de rede
3 Barra do menu
4 Barra de ferramentas
5 DTM/visualização do parâmetro
6 Diálogos opcionais
7 Barra de status

5.5  Configurações gerais

5.5.1  Configurações de projeto
1. No FieldCare, clique em Extras→ Options.

2. Clique na aba Projeto.
 A aba "Project" é exibida.

3. SelecionePrompt for project at start-up e clique em OK.
 O diálogo do projeto é exibido a cada vez que o programa é iniciado.



FieldCare SFE500 Operação

Endress+Hauser 19

5.5.2  Configurações de varredura
1. No FieldCare, clique em Extras→ Options.

2. Clique na aba Scanning.
 A aba "Scanning" é exibida.

3. Selecione a caixa de seleção ao lado deConnect after scanning if only one device is
found and automatically open the DTM in the Online window e clique em OK.

Uma vez que a rede for ajustada, o resultado da varredura é exibido.

Após a varredura, se o FieldCare somente encontrar um equipamento, uma conexão
automática é estabelecida com a DTM e ligada. Onde mais de um equipamento for
encontrado, a DTM deve conectar separadamente. Dependendo da DTM, um clique
duplo em um equipamento desconectado também iniciará a conexão. Se não for o
caso, a opção Conectar deve ser usada. A configuração de equipamentos individuais
não está descrita nessas Instruções de operação. Essa informação pode ser encontrada
nas Instruções de operação do equipamento em questão.

Por configuração padrão, o FieldCare usa as interfaces FDT 1.2 para executar uma
varredura. Se a opção "Preferir varredura FDT 1.2.1" estiver habilitada, as opções de
varredura FDT 1.2.1 podem ser usadas como uma alternativa.

FDT 1.2.1 pode oferecer vantagens em termos de velocidade, quando realizar a
varredura com Comm/Gateway DTMs.

5.5.3  Visualização da fábrica
Alterações na visualização da rede são automaticamente sincronizadas com a
visualização da fábrica. Alterações manuais à visualização da fábrica não afetam a
visualização da rede. Assim, é possível projetar uma fábrica independentemente da
topologia da rede.

Adicionar um novo nível
1. Clique com o botão direito no item.

2. Clique em Visualização da fábrica → Adicionar nível da fábrica.
 Um novo nível da fábrica pode ser selecionado.
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 2 Estrutura da visualização da fábrica

Nível da fábrica Descrição

Empresa Apenas crie uma entrada desse tipo no nível superior 0.

Sistema
Faixa
Célula do processo
Unidade

Criar no nível 1.

Faixa
Célula do processo
Unidade

Criar sob tipo "Local".

Célula do processo
Unidade

Criar sob tipo "Área".

Unidade Crie sob tipo "Célula do processo".

Equipamento de análise
Equipamento digital
Medidor de pressão
Especial
Medidor de vazão
Transmissor de nível
Medidor de temperatura
Válvula
Equipamento desconhecido

Criar sob tipo "Unidade".

Item Alterar item subsequentemente com Alterar software.

 Não há mais possibilidade retrospectivamente para outros tipos.
Neste caso, o tipo pode ser deletado e um novo ser criado.

 Uma entrada pode ser ligada logicamente a um equipamento na visualização de rede com a função
Atribuir. Delete o link usando Cancelar atribuição do equipamento.
Os textos de legenda para todas as entradas podem ser modificados subsequentemente.
Uma observação pode ser inserida para cada entrada pelo menu de contexto, ou cada entrada pode ser
ligada a um arquivo ou URL de site.

A visualização de rede deve ser criada primeiramente antes da visualização da fábrica ser
criada. A visualização da fábrica corresponde à topologia real dela; a visualização da
tecnologia é uma representação do processo de produção. Qualquer usuário com a função
de "Engenheiro de planejamento" ou superior pode criar novas visualizações ou modificar as
já existentes.
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Os itens podem ser alterados na visualização da fábrica. Os elementos na visualização da
fábrica podem ser renomeados, adicionados ou deletados.

Coluna Uso

Identificação da fábrica Identificação da fábrica para cada posição da fábrica.

Conexões Símbolo indicando o status online/offline.

Status Indica o status de diagnóstico atual.

Monitorado Opção para habilitar o monitoramento do equipamento atual pelo Monitoramento
de condição.

Crítico Opção para especificar se o equipamento for um equipamento crítico.

Canal Indica o canal pelo qual o equipamento está conectado.

Endereço Indica o endereço do equipamento que foi atribuído a essa posição da fábrica.

Tipo de equipamento
(DTM)

Indica qual tipo de equipamento ele é.

Equipamento físico Identifica o equipamento físico no ponto específico na rede.

5.5.4  Visualização de rede
A visualização da rede é uma representação gráfica da rede do equipamento pertencente a
um projeto FieldCare.

Coluna Uso

Identificação da rede Identificação da rede do equipamento.

Conexões Símbolo indicando o status online/offline.

Canal Indica o canal pelo qual o equipamento está conectado.

Endereço Endereço exclusivo da rede do equipamento.

Tipo de equipamento (DTM) Identifica o tipo de equipamento para cada equipamento individual.

Equipamento físico Identifica o equipamento físico no ponto específico na rede.

5.6  Funções gerais
Visualização da rede/fábrica
• Pelo Menu de contexto → Customizar visualização da fábrica
• Exibir diálogo
• Exibir/esconder colunas
• Ajustar a ordem das colunas

Função de lista
• Ajustar de modo que as listas sejam organizadas de acordo com o cabeçalho da coluna
• Alterar a largura da coluna
• Alterar a ordem das colunas usando "Copiar" e "Colar"

5.7  Verificar a rede
A topologia da rede no FieldCare pode ser comparado contra a rede física real. Isso é
particularmente útil se um equipamento for adicionado a uma rede existente. Um projeto
pode ser preparado offline e depois ser carregado pelo FieldCare. Deste modo, é possível
verificar a topologia atual na rede e a topologia física para fazer quaisquer alterações
necessárias.

Antes de verificar a rede, observe que apenas as redes verificadas são checadas para
equipamentos de comunicação que tenham pelo menos uma DTM. Caso contrário, o
item de menu Verificar a rede é desabilitado.
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Verificar a rede
1. Na visualização da rede, selecione um equipamento com pelo menos uma DTM.

2. Clique em Verificar a rede  na barra de ferramentas.
 A caixa de diálogo "Canal de comunicação" é aberta.

3. Selecione o canal desejado e clique em OK.
 O FieldCare escaneia o canal desejado.

Uma vez que a rede tenha sido verificada, a caixa de diálogo "Resultado da
varredura" é aberta.
Uma lista atual é exibida e a coluna de Status indica como os equipamentos na
topologia pré-planejada se adequam à topologia real.
Há cinco estados diferentes no total:
Os tipos de equipamento e números de série são idênticos.
Os tipos de equipamento são idênticos.
Os tipos de equipamento são diferentes.
Um novo equipamento foi encontrado.
Equipamento inesperado no projeto.

4. Alterações podem ser feitas no menu de contexto do equipamento em questão. Leia/
escreva dados do equipamento ou substitua o tipo de equipamento.
Clique em OK para confirmar as alterações.
 As alterações são salvas.
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6  Integração do sistema

6.1  Configuração de um endereço de IP
• Direitos de administrador são necessários
• A descrição aplica-se ao Windows 7

Todos os equipamentos Endress+Hauser com uma interface Ethernet são fornecidos com
um endereço de IP padrão, por ex. o endereço de IP para Fieldgate FXA720 é
192.168.253.1. Para o computador central ser capaz de comunicar com o servidor de rede
Fieldgate FXA720, deve ser alocado um endereço de IP no mesmo endereço de domínio,
por ex. 192.168.253.99. Para maiores informações, entre em contato com seu
administrador de rede.

Configuração do endereço IP do computador
1. Clique em Iniciar → Painel de controle → Rede e Internet → Rede e Central de

compartilhamento.
 A caixa de diálogo "Conexões de rede " é aberta.

2. Clique em Gerenciar conexões de rede.

3. Clique com o botão direito nas conexões que devem ser alteradas.

4. Se necessário:
Insira a Senha do administrador ou confirmação.

5. Clique com o botão direito na aba Rede.

6. Clique em Protocolo de internet versão 4 (TCP/IPv4) na entrada "Essa conexão usa
os seguintes itens".

7. Clique em Propriedades.

8. Observe os valores originais do endereço de IP e a máscara de sub-rede do
computador para restaurá-los se necessário ao final da operação. Um computador
usado em uma rede da empresa obterá seu endereço automaticamente.
Clique em Use os seguintes endereços de IP.

9. Insira o endereço de IP, a máscara de sub-rede e o gateway padrão para "TCP/
IPv4".
 As configurações do endereço de IP são aceitas.

10. Clique em OK.
 O procedimento é concluído.

6.2  Firewall do Windows
Se firewalls estiverem em uso nos computadores em que estão os servidores e clientes,
eles devem estar programados para permitir acesso mútuo. Como a configuração de
firewall é geralmente uma questão de política de segurança de empresa de TI, seu
administrador de sistema deve ser consultado antes de proceder. Além disso, os
direitos de administração são necessários para executar essa tarefa.

As portas disponíveis para o Fieldgate SFG500 estão listadas na tabela abaixo:

Número da porta ID

TCP 60010 TCP_PCPS2_SFG500_PORT

UDP 60015 UDP_IDENTIFY_PORT

UDP 60020 UDP_ANNUNC_PORT
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Gerenciamento do firewall do Windows
1. Pressione Iniciar → Painel de controle → Firewall do Windows .
2. No painel esquerdo, clique em Permitir um programa ou recurso pelo Firewall do

Windows .
3. Se necessário:

Insira a senha do administrador.

4. Clique na caixa ao lado do programa que deve ser habilitada e clique em OK.

5. No painel esquerdo, clique em Configurações avançadas.

6. Se necessário:
Insira a senha do administrador.

7. Na caixa de diálogo "Firewall do Windows com segurança avançada", clique em
Regras de entrada.

8. No painel esquerdo, clique em Nova regra.

9. Siga as instruções no assistente de Nova regra de entrada.

10. Altere para a Aba de exceções.
 Dois níveis principais são abertos. Exceções podem ser adicionadas nesses níveis.

"Adicionar programa" especifica quais aplicações são capazes de responder a
solicitações não-solicitadas.
"Adicionar porta" especifica que o firewall deve permitir tráfego TCP em portas
usados pelos servidores.

11. Na aba "Geral", clique em Ligado (recomendado), na caixa de verificação.

O firewall agora está ativo.
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7  Operação
Os dados relacionados ao projeto são salvos em um banco de dados ou em arquivos,
dependendo do modo de armazenamento do projeto.

7.1  Configuração do idioma de operação
1. Abra o FieldCare.

2. Extras →Options deve ser selecionado.
 A caixa de diálogo “Options” é aberta.

3. Selecione o idioma na abaDisplay e clique em OK.
 O idioma é salvo e disponível da próxima vez que o programa for iniciado.

7.2  Criação de um projeto
As primeiras etapas na criação de um projeto são sempre idênticas. Por padrão, a
caixa de diálogo do FieldCare é exibida e pode ser desativada em Extras→ Options →
Project. Se a caixa de seleçãoNone estiver ativada, a caixa de diálogo FieldCare não
será exibida.
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Criação de um projeto
1. Abra o FieldCare.

 A caixa de diálogo “FieldCare” é aberta.

2. Na aba "New", selecione a entradaCreate Project e clique em Open.
 O FieldCare abre um novo projeto com um PC host.

7.3  Salvando um projeto
Projetos FieldCare são armazenados em uma base de dados mas não são acessíveis
como arquivos no disco rígido. É possível acessar esses arquivos usando FieldCare no
modo de arquivo. Todos os projetos são salvos da mesma forma.

Salvando um projeto
1. File →Save As deve ser selecionado.

 A caixa de diálogoSave Project As é aberta.

2. Insira o nome do projeto e clique em Save.
 O projeto é salvo.
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7.4  Abrindo um projeto salvo
Abrindo um projeto salvo
1. Na caixa de diálogo FieldCare, clique na aba Existing.

 A caixa de diálogo "Open Project" é exibida com os últimos projetos abertos.

2. Selecione o projeto desejado e clique em Open.
 O projeto é exibido.

Se o projeto não aparecer na tela, clique em View→ Network.

7.5  Exportar CSV e importar
A informação estrutural da fábrica e a visualização da rede (fábrica/topologia de rede)
pode ser exportada a um arquivo CSV e importada de um arquivo CSV para um projeto
FieldCare .

Importação de um arquivo CSV
1. Crie um projeto. →   25

2. Clique em Arquivo → Importar/Exportar → Importar arquivo CSV.
 A caixa de diálogo "Importar CSV" é aberto.

3. Selecionar um arquivo e clicar em Abrir.
 Os dados no arquivo CSV são importados na visualização da fábrica e/ou

visualização de rede.

Exportação do arquivo CSV
1. Selecione um projeto.

2. Clique em Arquivo → Importar/Exportar → Exportar arquivo CSV.
 A caixa de diálogo "Topologia exportada" é aberta.

3. Clique em Exportar.

4. Selecione um local de armazenamento e um nome em clique em Salvar.
 A visualização de rede é exportada a um arquivo CSV.

7.6  Informação DTM
A caixa de diálogo Information contém um resumo de todas as informações relevantes do
DTM.
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Exibição das informações do DTM
1. Clique emDevice Catalog na barra de menu.

2. Clique em View.
 O catálogo de equipamentos é aberto.

3. Clique com um botão direito na DTM.

4. Clique em DTM Information.
 A caixa de diálogo "Information" é aberta.

Opções possíveis na caixa de diálogo "Information"
• Exibe informações básicas de todos os tipos de equipamento que a DTM suporta
• Exibe informações da DTM:

• ID do fabricante
• ID do tipo de equipamento
• ID do tipo de subequipamento
• Informações do tipo de equipamento

7.7  Exibição do catálogo do equipamento
A caixa de diálogo Catálogo do equipamento contém a lista de todas as DTMs e pacotes
FDI que atualmente estejam no sistema de gerenciamento do equipamento. As DTMs
podem ser agrupadas por categoria, fabricante ou protocolo.

1. Clique em Catálogo do equipamento na barra do menu.

2. Clique em Exibir.
 O catálogo do equipamento se abre.

7.8  Atualização do catálogo do equipamento
Informações detalhadas sobre a "Atualização do catálogo do equipamento":
Inicialização →   8
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8  Diagnósticos e solução de problemas

8.1  Solução de problemas geral

Problema Solução de problemas

O servidor de SQL do
FieldCare falha na
inicialização.

Iniciar o servidor de SQL manualmente:
• Iniciar o Windows e inserir services.msc no campo de busca.
• Selecione Servidor SQL (SQLFIELDCARE).
• Clique em Iniciar.

Fazer a verificação de macros
que estejam faltando.

Importar macros:
• Na pasta "...\Endress+Hauser\FieldCare\db" importar o arquivo

ImportScanningMacros.cmd.
• Depois reinicie o FieldCare.

Duplique as entradas do menu
ou do Windows que estejam
faltando.

Reinicie o layout:
• Feche o FieldCare.
• Na pasta "...\Endress+Hauser\FieldCare\Profiles", delete o arquivo

profile.xml.

Catálogo do equipamento com
falha.

Reinicie o catálogo do equipamento FieldCare:
• Feche o FieldCare.
• Na pasta "...\Endress+Hauser\FieldCare\Frame", delete o arquivo

FRMRepository.xml.
• Reinicie o FieldCare e atualize o catálogo do equipamento.

Em casos de possíveis problemas, entre em contato com a sua organização de vendas
Endress+Hauser: www.addresses.endress.com
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9  Atualizações de software
Informações detalhadas sobre a "Atualização de software ": Inicialização →   8
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